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AMERICAN NATIONAL STANDARDS ON ACOUSTICS
The Acoustical Society of America (ASA) provides the Secretariat for Accredited Standards Committees S1 on Acoustics, S2 on Mechanical Vibration and Shock, S3 on Bioacoustics, S3/SC 1 on Animal Bioacoustics, and S12 on Noise.  These committees have wide representation from the technical community (manufacturers, consumers, trade associations, organizations with a general interest, and government representatives).  The standards are published by the Acoustical Society of America as American National Standards after approval by their respective Standards Committees and the American National Standards Institute (ANSI).
These standards are developed and published as a public service to provide standards useful to the public, industry, and consumers, and to Federal, State, and local governments.
Each of the Accredited Standards Committees (operating in accordance with procedures approved by ANSI) is responsible for developing, voting upon, and maintaining or revising its own Standards.  The ASA Standards Secretariat administers Committee organization and activity and provides liaison between the Accredited Standards Committees and ANSI.  After the Standards have been produced and adopted by the Accredited Standards Committees, and approved as American National Standards by ANSI, the ASA Standards Secretariat arranges for their publication and distribution.
An American National Standard implies a consensus of those substantially concerned with its scope and provisions.  Consensus is established when, in the judgment of the ANSI Board of Standards Review, substantial agreement has been reached by directly and materially affected interests.  Substantial agreement means much more than a simple majority, but not necessarily unanimity.  Consensus requires that all views and objections be considered and that a concerted effort be made towards their resolution.
The use of an American National Standard is completely voluntary.  Their existence does not in any respect preclude anyone, whether he or she has approved the Standards or not, from manufacturing, marketing, purchasing, or using products, processes, or procedures not conforming to the Standards.
NOTICE:  This American National Standard may be revised or withdrawn at any time.  The procedures of the American National Standards Institute require that action be taken periodically to reaffirm, revise, or withdraw this Standard.
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Contents	Comment by ASA Standards:  This Contents table will update based on use of header styles. To make sure a header appears on the table of contents:
Highlight the text within the main document that you wish to make into a header.
Go to the “Home” ribbon 
Select the “Styles” tab
Select the appropriate level of heading from the styles: Heading 1 for Clause headings, Heading 2, for subclause headings, and so on. Headings are available for up to level 6 subclauses, as 4.1.1.1.1.1.1.
The text should update to match the style. 

Then, to update the Table of Contents to reflect the new heading:
 Disable “Track Changes” (in Review ribbon)
 Right click (PC) or click with two fingers (Mac) on the Table of Contents object, and select “Update Field.” 
“Update entire table” will include any changes you’ve made to headings within the text.
“Update page numbers only” will simply update the Table of Contents to match the document’s current pagination.
 Each table (Contents, Tables, and Figures) must be updated separately

Note: The Table of Contents does not contain third-level and lower headings.
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Foreword	Comment by ASA Standards: For more information about the Foreword pages, see section 3.5 of the Editorial Guidelines.
The Foreword shall include as many of the following items as appropriate: (1) a brief history of the standard, (2) special remarks about use or application of the standard, and (3) if it is a revision of an American National Standard, an explanation of the principal differences between the current and the previous version. If the proposed standard is a national adoption of an International Standard, the principal technical differences, if any, that were needed to make the International Standard conform to national requirements should be explained. Do not include material in the Foreword that is appropriate for the scope. No normative material or requirements shall be included in the Foreword. The content of the Foreword shall be within the scope of the document and the scope of the Accredited Standards Committee.
[This Foreword is for information only, and is not a part of the American National Standard BSR/ASA S12.##-20XX American National Standard Standard Title. As such, this Foreword may contain material that has not been subjected to public review or a consensus process. In addition, it does not contain requirements necessary for conformance to the standard.]
This standard comprises a part of a group of definitions, standards, and specifications for use in acoustics.  It was developed and approved by Accredited Standards Committee S12 Noise, under its approved operating procedures.  Those procedures have been accredited by the American National Standards Institute (ANSI).  The Scope of Accredited Standards Committee S12 is as follows: 
Standards, specifications, and terminology in the field of acoustical noise pertaining to methods of measurement, evaluation, and control, including biological safety, tolerance, and comfort, and physical acoustics as related to environmental and occupational noise.
This standard is/is not comparable to any existing ISO/IEC Standard. <If it is comparable to an ISO or IEC standard, explain here.>	Comment by ASA Standards: Select one of these options and fill in appropriate details. Delete the other options.
This standard is/is not a nationally adopted international standard. (national adoption means it is identical and we changed nothing of the text in the ISO/IEC standard)
This standard is/is not a modified nationally adopted international standard. (modified means we did change some of the text in the ISO/IEC standard)
This standard is a revision of ANSI S12.##-yyyy, which has been technically revised.  <Insert a brief description of the revision(s) contained in this edition.> 
This standard includes ## Annexes.  Annex A is normative and is considered to be a part of this standard. Annex B is informative and is not considered part of this standard.	Comment by ASA Standards: Select the sentence for ‘Normative” or “Informative” that corresponds to each Annex as appropriate.
At the time this Standard was submitted to Accredited Standards Committee S12, Noise, for approval, the membership was as follows:
Stephen J. Lind, Chair
Douglas F. Winker, Vice-Chair
Nancy Blair-DeLeon, Secretary

3M Personal Safety Division	Cameron Fackler

Acoustical Society of America	Robert D. Hellweg
	David Lubman (Alt.)

Air-Conditioning, Heating and Refrigeration Institute	Stephen J. Lind
	Ladan Bulookbashi (Alt.)

American Academy of Audiology	Todd Ricketts
	Jason Galster (Alt.)

American Speech-Language-Hearing Association	Laura A. Wilber
	Neil DiSarno (Alt.)

Boeing Commercial Airplanes, Noise, Vibration and Emissions	K. Lai
	M. Kosanchick (Alt.)

Caterpillar, Inc.	Clinton Metzger
	Charles Crowell (Alt.)

Council for Accreditation in Occupational Hearing Conservation	Charles Moritz
	Chandran Achutan (Alt.)

Cummins, Inc.	Shashikant More

Custom Protect Ear, Inc.	Alexei Bobyrev

Department of Defense – Hearing Center of Excellence	Douglas Brungart
	Robert Williams (Alt.)

Emerson Electric – Copeland Corporation	Ali T. Herfat
	Miles Strand (Alt.)

ESI Group	Chadwyck Musser
	Bryce Gardner (Alt.)

ETS – Lindgren Acoustic Systems	Douglas F. Winker
	Michael Black (Alt.)

ExxonMobil	Brad Moulton
	Noel Hart (Alt.)

G.R.A.S. Sound & Vibration	Robert O’Neil

GE Aviation	Rudramuni Majjigi
	Robert Babbitt (Alt.)

General Motors	Douglas B. Moore

Gentex Corporation	Brian Fowler
	Jacob Chaloux (Alt.)

Honeywell Safety Products	Theresa Schulz
	Robert Ghent (Alt.)

Information Technology Industry Council	Willem M. Beltman
	Joshua Rosenberg (Alt.)

Institute of Noise Control Engineering	Beth A. Cooper
	Robert O. Rasmussen (Alt.)

International Safety Equipment Association	Jeff Birkner
	Cristine Z. Fargo (Alt.)

International WELL Building Institute	Ethan Bourdeau
	Nathan Stodola (Alt.)

John Deere	Sam Suh

Josephson Engineering, Inc.	David L. Josephson

National Council of Acoustical Consultants	Bennett M. Brooks

National Hearing Conservation Association	Laurie Wells

National Institute for Occupational Safety and Health	William J. Murphy
	Edward Zechmann (Alt.)

National Institute of Standards and Technology – National 
Voluntary Laboratory Accreditation Program	Kari Harper

National Park Service	Megan McKenna 
	Kurt Fristrup (Alt.)

Nexteer Automotive	Robert Taub

Noise Control Engineering, Inc.	Allan Beaudry
	Jesse Spence (Alt.)

Noise Pollution Clearinghouse	Les Blomberg

Owens Corning	Kevin Herreman

Power Tool Institute, Inc.	William D. Spencer
	Mark Hickok (Alt.)

U.S. Air Force	Richard L. McKinley
	Hilary Gallagher (Alt.)

U.S. Army Aeromedical Research Laboratory	William A. Ahroon

U.S. Army Construction Engineering Research Laboratory	Michael J. White
	Michelle Swearingen (Alt.)

U.S. Army Public Health Command	Catherine Stewart
	Charles Jokel (Alt.)
	John Merkley (Alt.)

U.S. Army Research Laboratory, Human Research and Engineering Directorate	Angelique A. Scharine
	Paul Fedele (Alt.)

U.S. Department of Transportation	Jason Broehm
	Chris Roof (Alt.)

U.S. Naval Surface Warfare Center - Carderock	Alexey Titovich
	Deidre Gilmer (Alt.)

Université du Québec ETS	Jeremie Voix
	Rachel Bouserhal (Alt.)


Individual Experts of Accredited Standards Committee S12, Noise, were: 
	Bennett M. Brooks
	David Lubman
	Rich Peppin

	Lawrence Finegold
	Richard McKinley
	Jeff Schmitt

	Robert D. Hellweg
	David Muchaud
	Paul D. Schomer 

	Arnold Konheim
	Matt Nobile
	Laura A. Wilber

	Stephen Lind
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Working Group S12/WG ##, <Insert WG Title>, which assisted Accredited Standards Committee S12, Noise, in the development of this standard, had the following membership.
Name, Chair
Name (if there is a Vice Chair), Vice-Chair

	MEMBER	MEMBER	MEMBER
	MEMBER	MEMBER	MEMBER
	MEMBER	MEMBER	MEMBER
	MEMBER	MEMBER	MEMBER

Suggestions for improvements to this standard will be welcomed.  They should be sent to Accredited Standards Committee S12, Noise, in care of the Standards Secretariat of the Acoustical Society of America, 1305 Walt Whitman Road, Suite 300, Melville, New York 11747. Telephone: 631-390-0215; FAX: 631-923-2875; E-mail: standards@acousticalsociety.org.
Introduction	Comment by ASA Standards: For more information about the Introduction, see section 3.6 of Editorial Guidelines.
Replace this text with your introductory text. An introduction is optional. Do not duplicate the Scope or Foreword.  Do not include any requirements. If a more detailed description of the background for the standard is considered appropriate, it shall be placed in an informative annex.


Draft American National Standard
Standard Title
Scope 	Comment by ASA Standards: For more information about Scope section, see section 3.8 of Editorial Guidelines.
Insert the text here. The scope should explain what is and, if necessary, what is not covered by the proposed standard. The scope of a standard shall not exceed the approved scope of the Accredited Standards Committee. The scope shall not contain requirements. In standards that are subdivided into parts, the scope of each part shall describe only the subject of that part of the standard.
The statement of the scope of a standard shall cover as many of the following items as applicable:
general description of the subject of the standard, the aspects covered, and the fundamental assumptions on which the standard is based,
indication of the uses of the data or devices developed in accordance with the standard,
indication of the intended users of the standard,
a statement of the possible consequences of the use of the procedure, methods, or quantities addressed by the standard
a description of the applications, or field of applications, for the standard.  
[bookmark: _Toc27318987]Normative references	Comment by ASA Standards: For more information on normative references, see section 3.9.1 of the Editorial Guidelines.
The following referenced documents are indispensable for the application of this standard.  For dated references, only the edition cited applies.  For undated references, the latest edition of the referenced document (including any amendments) applies. 
Use Normal style for normative references. If no normative references are needed, delete the heading for “normative references” and begin the text at Clause 2 for “terms and definitions.” The following are examples of normative references; please replace with your own.
ANSI/ASA S1.4-2014/Part 1 /IEC 61672-1:2013 Electroacoustics – Sound Level Meters – Part 1: Specifications
ANSI/ASA S1.6-2016 American National Standard – Preferred Frequencies, Frequency Levels, and Band Numbers for Acoustical Measurements
IEC 60537:1976 Frequency weighting for the measurement of aircraft noise (D-weighting)
IEC 61012:1990 Filters for the measurement of audible sound in the presence of ultrasound
IEEE 260.4-2018 Standard for Letter Symbols and Abbreviations for Quantities Used in Acoustics
ISO 7196:1995 Acoustics – Frequency-weighting characteristic for infrasound measurements
[bookmark: _Toc27318988]Terms and definitions	Comment by ASA Standards: For more information about formatting terms and definitions, see section 3.10 of Editorial Guidelines. For more information about formatting Notes and examples, see section 3.14 of Editorial Guidelines.
This is an OPTIONAL element. If there are terms that need to be defined for the purpose of this standard, define them here. Insert the text here using the Definition Style. See Clause 3 and Annex B of the Editorial Guidelines for Preparation of American National Standards in Acoustics, Mechanical Vibration and Shock, Bioacoustics, and Noise for guidance in creating definitions. Follow the format in the example below.  Begin the clause with the following "boiler plate” language:
For the purposes of this standard, the terms and definitions given in <Insert designation of appropriate terminology standard, e.g., ANSI/ASA S1.1> and the following apply:
3.1 term. a technical word or phrase used in a specific context within this standard. 	Comment by ASA Standards: Note to user: Use Definition style for definitions. The term should also be bolded. Use NOTE style for notes
3.2 adaptor. Mechanical fixture inserted between the microphone and preamp. 
NOTE 1		For the purposes of this standard, the adaptor may be metal or plastic.
NOTE 2		An adaptor may have a screw or snap on connector.
[bookmark: _Toc27318989]First requirements clause title
[bookmark: _Toc27318990]Subclause with notes on various styles	Comment by ASA Standards: These clauses and subclause may be copied and pasted below to create additional clauses. For more information regarding formatting, see section 3.12 of the Editorial Guidelines.
Insert text describing the normative requirements of the standard here. Most text in clauses and subclauses is formatted using the Normal Style in 10 point type. Although there are some instances where you will use different styles, which are listed in the following subclauses.
2nd level subclause with notes and examples
Notes and examples use the Note Style.  The format for placing notes in a standard is slightly different if there is one note or example being inserted or two or more.
Example	 of a single note:
NOTE 		When a single note is inserted it is not numbered.  Using the NOTE Style, type the word NOTE in capitals and strike the TAB key to position the cursor to begin the note. 
Example of insertion of two or more notes:
NOTE 1 		The word "NOTE" preceded the numeral that is assigned to the NOTE.
NOTE 2 		Each note is numbered, with no en-dash or other punctuation separating the number and the text, just a blank space.  
Notes and examples should be placed at the end of the clause or subclause, or after the paragraph to which they refer.
EXAMPLE	Notes and Examples integrated into the text of a standard are preceded by the word NOTE or EXAMPLE in all capital letters.
3rd level subclause with information about Lists
Insert the text here using the Normal Style.  When you want to create a list, choose the list type from the styles offered.
List Bullet styles (for unordered lists)
List Number styles (for ordered lists)
4th level subclause
Insert subclause text here using the Normal Style.
[bookmark: _Toc27318991]Equations	Comment by ASA Standards: For more information about formatting equations, see section 3.19 of Editorial Guidelines.
Each equation should be numbered within parenthesis at the right-hand margin as shown. Use the Equation Style for the equations and their numbering.
The level is given by
		Comment by ASA Standards: For best formatting of equations:
 Create a table with two cells (Insert > Table, 1 row, 2 columns)
 In left-hand column insert your equation using the Equation tool (found under the Insert menu).
 Once equation is written, hover mouse over equation box. An arrow will appear to the right of the equation. Select “Change to Display.” 
 In righthand column, insert equation number (see previous  comment)
 Select table, right click, go to “Borders and Shading,” and remove borders.

	(1)	Comment by ASA Standards: To create sequential numbering for your equations:
 Go to Insert menu and select “Field”
 From the “Field Names” list, select “Seq”
 A textbox will open with the word “Seq” in it. Add “eq” after, so the textbox reads, “Seq eq”
 Click OK.

Please note that if you insert a new equation in between two other equations, this numbering will not update automatically; you will need to right click (PC) or click with two fingers (Mac) on the field and select “Update Field” on the drop-down menu for the numbering to update.


where p0 is 20 Pa.
The area of a circle is given by
	
	(2)


where r is the radius.
The Taylor expansion is given by
	
	(3)



The Fourier series is given by
	
	(4)



[bookmark: _Toc27318992]Tables	Comment by ASA Standards: For more information about formatting tables, see section 3.20 of Editorial Guidelines.
Tables should be prepared using the Table layout tool. Format the table caption with the Table Caption style. Format the table content using one of the Table Text styles. 
[bookmark: _Toc27318972]Table 1 – Sample table without notes or footnotes.
	Type
	Distance
(m)
	Sound Pressure Level
(dB)

	1
	1.0	Comment by ASA Standards: To align numbers on the decimal point:
 Highlight the text
 From the Format menu, choose “Paragraph”
 Click “Tabs…” button
 For “Alignment,” select “Decimal”
	50

	2
	1.5
	55

	3
	2.0
	60

	4
	2.5
	65

	5
	3.0
	70

	6
	3.5
	75

	7
	4.0
	80

	8
	4.5
	85 



Place notes and footnotes within the frame of the table. Indicate notes to a table by the sequence NOTE 1, NOTE 2, etc., with a new sequence for each table.
A single note shall be preceded by the word NOTE.
[bookmark: _Toc27318973]Table 2 – Sample table with notes and footnotes.
	Category 1
	Category 2
	Category 3
	Category 4
	Category 5

	100
	200a
	300
	400
	500

	NOTE     Insert Table Note text here

	a  Insert Table footnote here using the Table Footnote Style



[bookmark: _Toc27318993]Figures	Comment by ASA Standards: For more information about formatting of figures, see section 3.21 of Editorial Guidelines.
You may want to insert information or graphs.  Use the Figure Caption Style to format the figure number and caption. Figure numbers and titles are centered below the figure. Figures shall be centered, cropped, and sized so that text in the figure, including axis labels, appear the same size as normal 10 pt. type in the main text of the standard. The Figure is inserted as an enhanced windows meta file (*.emf).
[bookmark: _Toc25996621]No table of figures entries found.Figure 1 – Caption for sample Figure 1.

Both notes and footnotes to figures shall be treated independently from notes integrated in the text. They shall be located above the title of the relevant figure. Notes shall precede figure footnotes (if any).
[bookmark: _Toc25996622]No table of figures entries found.Figure 2 – Caption for sample Figure 2.

[bookmark: _Toc176241962][bookmark: _Toc27318994][bookmark: _Toc176241963] 

(Indicate if normative or informative) 

Insert Annex Title	Comment by ASA Standards: For more information about formatting of Annexes, see section 3.22 of Editorial Guidelines.

[bookmark: _Toc27318995]Annex clause
The clauses, subclauses, tables, figures and mathematical formulae of an annex shall be numbered using the letter designating that annex followed by a period (full stop) then the numeral(s) for that clause or subclause. The numbering shall restart with each annex. A single annex shall be designated “Annex A”.
Use Styles A.2, A.3, etc., to generate headings for clauses and subclauses within an annex.
Description of normative annex 
A normative annex shall be referred to as such in the main body of the standard, by the second line of the title of the annex, by the listing of the annex in the Contents, and by the choice of the verb forms for the text of the annex.
Description of an informative annex
Informative annexes provide additional, but non-essential information. They are provided only for clarification, illustration, and general information about the standard. For many standards it is appropriate and desirable to include additional related information for general use and guidance. Such information, however, cannot be a normative part of the standard and is appropriately included in an informative annex.
No material that is rightfully a normative part of a standard shall be placed in an informative annex. The material in an informative annex shall be within or closely related to the scope of the standard and not inconsistent with the standard itself. If the material is rightfully part of the standard, it shall be included as a normative annex and so identified as described in 3.22.3.
NOTE 			Although an informative annex is not a normative part of a standard, it is included in the overall approval process by the Standards Committee.
Examples of material appropriate for an informative annex include:
Remarks about significance and interpretation of the standard, for example, to amplify or explain a statement in the text of the standard;
Background for, and development of, equations used in calculations;
Charts, tables, graphs, or supplementary information needed for computations;
Data forms for recording of test results (such forms may also be given in a normative annex);
Comments on the rationale for development of the method or procedure in the standard;
Software accompanying a standard.
Information about software accompanying a standard and instructions for its use.
An informative annex may contain equations, tables, and figures but may not include normative information, such as requirements. Such equations, tables, and figures shall have an identification that is unique to each annex.



Bibliography	Comment by ASA Standards: For more information on formatting bibliography, see section 3.23 of Editorial Guidelines.
Surname, Initials or First name of Author. Title of Book. City of Publication: Publisher, year.	Comment by ASA Standards: Use Bibliography1 style to format bibliography entries.
Surname, Initials or First name of Primary Author, First name Surname of Second Author. Title of Book. City of Publication: Publisher, year.
Surname, Initials or First name of Primary Author, First name Surname of Second Author. "Title of Article." Title of Journal, Volume number, year: pages.
Surname, Initials or First name of Primary Author, First name Surname of Second Author. "Title of Article." Title of Journal, Volume number, year: pages. <http://www.online-location.com>
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